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1. About This Preview

Welcome to the KDE User Guide! Although this book is not yet complete and much of the
information will need to be rewritten for the final version of KDE, I hope this preview version will
be useful in answering some of the questions that a new KDE user may have.

1.1 Status of This Book

This book includes a complete introduction, a guide to KDE installation, a description of the
user interface, three practical examples on how to use KDE for daily work, and a description on
how to customize the KDE desktop. Also included is a table of shortcuts and some tips & tricks.

1.2 What is Missing

The reference part containing detailed descriptions (not the introductions) to the base KDE
software is outdated and will be rewritten from scratch. Also, the Tips & Tricks chapter needs
more content.

1.3 What I Urgently Need

I would also appreciate it if someone could keep an eye on the consistency of the expressions
used (e.g., telling me if I once again used X-Windows instead of The X Window System). If
someone volunteers to write an unwritten chapter or to contribute changes/additional material, I
would place his/her photo on my desktop with a golden border :-).

Although this book is nice for the beginner, we need more in-depth documentation for the
specific KDE applications. If you would like to contribute, please contact me immediately.
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2. Introduction

"640kB ought to be enough for everybody"
(The CEO of a big software company, at the beginning of the 80s...)

Since the beginning of UNIX development, there has been one great problem: There were
stable kernels, and good, powerful software. Unfortunately, only a few people could use UNIX,
because it was written mainly for those students and professionals who had studied the system
for a long time. For example, the standard method for reading USENET news was

 
find /var/spool/news -name '[0-9]*' -exec cat {} \;|more 

This problem has been solved. Today, there are many good frontends available, like tin and
knews, which provide easy-to-use, intuitive graphical user interfaces (GUIs). Unfortunately, the
GUIs lack a common "look-and-feel". Commercial libraries for programmers like Motif promised
a solution to this, but these libraries remain far too expensive and far too slow.

The configuration of programs is also often difficult. While compiling is usually done with

 
./configure && make && make install 

only a very few programs can be configured with menus or scripts. In most cases, you must
edit text configuration files yourself. It often happens that a misplaced period ruins the whole
file, forcing you to restart the configuration process. Whenever you need to change your
settings or reconfigure a program, the whole mess comes up again.

All this contributes to the fact that Linux and other UNIX's fail to reach a wider audience. At the
same time, many people are not satisfied with their current operating system, mainly because
of the lack of stability and performance found in those operating systems. Other people hate to
buy a new computer each time a new version of the program they cannot live without comes
out, because it needs more RAM and more disk space. Often the new version provides
functions few people really need.

KDE is different. Although we do not try to replace the standard UNIX shell, we are working on
a tool that will make using UNIX easier. We also want to attract more users to the UNIX
environment. Simple things will be made easy and complex things will still be possible. Also, a
single interface will be provided, instead of the dozens currently required.

K Desktop Environment : Introduction 

http://www.kde.org/documentation/userguide/index-2.html (1 of 3) [14/09/1999 10:32:14]

http://www.kde.org/


2.1 What KDE Can Do For You

We designed KDE mainly for those new to UNIX, and others who wish to avoid the complicated
process of learning new technologies and commands not found in their old operating systems.
We also provide, however, something for experienced UNIX users.

You are new to UNIX. Do not even try to use anything else, because you are exactly the
sort of person for whom we wrote this software. :-) For you, we provide:

A good-looking, easy to use windowing environment❍   

A powerful, easy to use file manager❍   

A simple, centralized configuration❍   

An online help that will support you in every situation❍   

●   

You already have experience in UNIX. As an experienced UNIX user, you will welcome
the new features KDE has to offer:

A good, handy, and fast window manager❍   

A consistent interface for your applications. You will no longer need to guess if the
right or the left mouse button does what you expect

❍   

A lean terminal emulator that does not fill up your memory when multiple windows
are open simultaneously

❍   

A stylish desktop that makes your friends jealous❍   

●   

2.2 Background of KDE

In October 1996, German LyX developer Matthias Ettrich initiated the development of KDE with
a USENET posting. Soon after, a couple of interested developers began planning and
programming parts of the new project. One year later, the window- and file-manager, the
terminal emulator, the help system and the display configuration tool were released for ALPHA
and Beta testing and proved to be relatively stable.

In July 1998, KDE 1.0 was released. It was the stable version for the next six months, while
developers continued work on improving KDE without stability constraints. In January 1999,
their improvements were consolidated and integrated to produce KDE 1.1, the new standard,
stable version.

Developers and interested users communicate via several mailing lists as described in the
Contacting the authors section. If you would like to help, please do so! We are still looking for
helpers.

2.3 Legal Notices

KDE is free software under the GNU General Public License (GPL), which is included with
every KDE component. You can copy and distribute KDE and its components as you like, as
long as you always include the complete source code. See the GNU General Public License
(GPL) section in the Appendix for details.

K Desktop Environment : Introduction 

http://www.kde.org/documentation/userguide/index-2.html (2 of 3) [14/09/1999 10:32:14]



2.4 How to Get New Components

The main site for KDE is http://www.kde.org. Here, you can find all important information relating to
KDE, including announcements, bugfixes, developer info, style guides, a considerable amount
documentation (including the newest version of this book), and much more. For software
upgrades, please visit our ftp site, ftp://ftp.kde.org or use a mirror if one exists near you.

The directory unstable always contains brand new software, but it often is untested and may not
even compile. If you are looking for more reliable components, please take a look in the stable
directory, where we put Beta and release versions.

If you are interested in developing KDE applications on your own, you should also visit Troll
Tech's server (http://www.troll.no) which features a great deal of information concerning the Qt
library used by KDE. For development work, it is also advisable to join the developer's mailing
list.

2.5 Contacting the Authors

Contact rwilliam@kde.org for questions about and critiques of this book. Because several
people contributed material to this book, everyone is also listed in The K Documentation staff.

Next Previous Table of Contents
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3. Installation

"Core dumping fsck's tend to make me nervous."
(Linus Torvalds, after finding one of his file systems smashed by a new Beta kernel)

Don't worry! Although the use of some Beta software can cause considerable grief, it is unlikely that the
installation of KDE will smash your hard disk. In fact, this chapter is designed to guide you through the
installation process so that you can take a look at your new desktop as quickly (and with as little grief) as
possible. As with all new Window Manager installs, it is recommended that you back up all your
X11-specific configuration files before you begin the install. If you do not know the exact location of them,
try all the hidden (.*) files in your home directory and the directory /usr/X11/lib/X11/xdm.

Because the software is in Beta stage at the moment, we strongly recommend that you back up
ALL the critical data on your hard disk. We are NOT liable for any damage caused by the
installation and usage of KDE!

3.1 Requirements

Before installing KDE, ascertain that your system fulfills the following requirements:
A running POSIX compatible UNIX system. UNIX's that are known to work with KDE include: Linux,
FreeBSD, Solaris, HP-UX, and MkLinux. We are working to make KDE available for more platforms
soon.

●   

Some free hard disk space on the partition where /opt/kde will be created. We recommend that you
reserve about 50MB if your system supports shared libraries, and considerably more if it does not.
Due to the fact that this software is currently in Beta stage, the requirements may change
from one week to another. I recommend that you reserve additional space for forthcoming
KDE applications. If you need or want to build KDE from the source tree , please remember to
reserve about 100MB in /usr/src.

●   

A running X11 system with or without xdm. If you have not installed the X Window System yet, first
check your UNIX installation media for an installable version. If you cannot find any version working,
visit the XFree86 web site for more information on how to get and install the X Window System, or
contact your UNIX vendor support.

●   

The qt-libraries, version 1.31 or higher. You can get these at Troll Tech's FTP Server in both rpm and
tgz format.

●   

A warning before you start: Before upgrading from a previous version of KDE, we recommend that
you do the following:

 
cd /opt/kde 
tar cfvz ~/KDE-old-version-backup.tar.gz * 

●   
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3.2 Linux: Installing RPMs for RedHat, Caldera and SuSE.

Using RPMs is the easiest method to get KDE up and running. Just visit your favorite KDE mirror and visit
the directory /pub/kde/stable/distribution/rpm. There, you can see directories for different operating
systems. Currently, the i386, alpha and sparc architectures are supported. The rpm packages can also be
found on the Red Hat contrib sites like sunsite.unc.edu or ftp.redhat.com.

The basic system consists of the files kde-(component).(architecture).rpm You need at least kdesupport,
kdelibs and kdebase. After getting the base distribution, feel free to download any other rpms that you think
may come in handy.

Next, start installing with the base package. If you are installing KDE for the first time, use

 
rpm -i kdesupport.arch.rpm 
rpm -i kdelibs.arch.rpm 
rpm -i kdebase.arch.rpm 

NOTE: It is important that these components are installed in the order listed, and that they are installed
before any other KDE component.

If you are upgrading from a previous release, try

 
rpm -Uvh kde-component.arch.rpm 

Once again, the order given above should be preserved, and the given components should be installed
before any other KDE components.

This will unpack the base distribution and install it in /opt/kde. If the installation of the base packages has
been successful, you can install the remaining packages (use -Uvh instead of -i once again to update an
existing version) the same way.

3.3 Linux: Installing on Top of a Debian/GNU Linux Distribution

An important note before you start: Due to various problems arising from the Linux filesystem standard,
building .deb packages is very complex. Therefore, you will probably not find the most current version. If
you want to see the newest in KDE development, we have to recommend you to get the source distribution
(see Using TGZ to install on top of other systems for details).

Retrieve the following files in order to get KDE installed on your Debian/ GNU Linux system. You can find
them in /pub/kde/unstable/distribution/dpkg.

libgif2_2.3-1_i386.deb●   

libkde0_0.10.01-1_i386.deb●   

kdeapps_0.10.01-2_i386.deb●   

In addition, KDE requires components from the following packages. Make sure they are installed before
beginning the KDE installation:

qt1.31●   

libjpeg6●   

libg++27●   

We highly recommend that you install the debian menu package before installing KDE (it makes
kpanel much nicer).

●   
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To install kde use dselect or do it manually using the following:

 
dpkg -i libgif2_2.3-1_i386.deb 
dpkg -i libkde0_0.10.01-1_i386.deb 
dpkg -i kdeapps_0.10.01-2_i386.deb 

If dpkg gives dependency errors, you'll have to find the packages, listed above, upon which KDE depends,
install them, then rerun the dpkg commands.

3.4 Using TGZ to Install on Top of Other Systems

If your Linux distribution did not come with an RPM or DEB archive format, or you are not using Linux at all,
you must compile KDE on your own. In the future, we are planning to provide a binary distribution which
includes its own installation program.

In order to compile and install KDE properly, you need to have the following items installed on your hard
disk:

An ANSI-C compiler, e.g. the GNU C compiler.●   

An ANSI-C++ compiler, e.g. GNU C++.●   

The make utility.●   

Qt development version 1.41 or higher.●   

X11 development version (include files are often missing)●   

Once you have all the needed helper applications, go to your favorite KDE mirror and retrieve the following
files from the directory /pub/kde/stable/(newest version):

kdesupport-(version).tar.gz●   

kdelibs-(version).tar.gz●   

kdebase-(version).tar.gz●   

any other packages you wish to install. We advise you to get at least kdeutils.●   

where (version) stands for the current version number. Once you have downloaded all you need, extract
these files to /usr/src. This process should yield the following directory structure:

/usr/src/kdesupport●   

/usr/src/kdelibs●   

/usr/src/kdebase●   

/usr/src/... (any other packages)●   

Make sure you have write permissions to /opt/kde. Next you must compile and install the packages using
the following:

cd into the directory of the package, you want to install (see above)●   

./configure (with the options you want to apply)●   

make●   

make install●   

Apply the above steps to every package you want to install. (Note: These instructions can be used for
almost every source package available.)

Every configure script has several options available. Some are common between the packages while
others are specific to an individual package. The following is the result of configure --help in kdebase:
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  --enable-debug          creates debugging code [default=no]
  --disable-nls           do not use Native Language Support
  --with-qt-dir           where the root of qt is installed
  --with-qt-includes      where the qt includes are.
  --with-qt-libraries     where the qt library is installed.
  --with-extra-includes   adds non standard include paths
  --with-extra-libs       adds non standard library paths
  --disable-path-check    don't try to find out where to install
  --with-install-root     the root, where to install to [default=/]
  --disable-rpath         do not use the rpath feature of ld
  --with-xdmdir           if the xdm config dir can't be found automatically   
  --without-pam           disable Pluggable Authentication Modules
  --with-shadow           if you want shadow password support
  --without-gl            disable 3D GL modes
  --without-xpm           disable color pixmap XPM tests

Several options are not required and are only useful as work arounds for known problems (e.g.
--disable-path-check). Since some are important options, for instance --with-shadow, you should always
check the available options.

An important option is --prefix. This option specifies the path where configure should install (for kdesupport
and kdelibs) or where to look for libraries (for the other packages). By default, configure will look in
/usr/local/kde. If you want to install KDE into /opt/kde, you have to use configure --prefix /opt/kde.

If you have installed the Qt libraries in an uncommon place, for instance in $HOME/src/qt, you must use
configure --with-qt-dir=$HOME/src/qt. By default configure looks in the most common places for QT before it
gives up.

If you have problems that you are not able to solve, send a copy of the file config.log to the address in the
README file in the offending package.

You must install KDE in the following order: kdesupport, kdelibs, then the application packages (for
example kdebase). All the application packages should only depend on kdelibs, so you can compile them
at the same time (if you have a powerful machine).

If you want to take advantage of multiprocessor systems, try make -j<Number of processors> instead of
make.

If you are able to install KDE on a UNIX flavor for which KDE has not yet been successfully installed,
please send me an email describing what you did. It will then be included in this document.

Platform Specific Building Notes

Linux

For Linux, most of the utilities needed to build KDE can be found either at
ftp://sunsite.unc.edu/pub/Linux/GCC or ftp://sunsite.unc.edu/pub/GNU. The Qt libraries can be found at
ftp://ftp.troll.no/pub/qt/linux, available in source or RPM format for Linux. Both contain detailed instruction
on how to install them. Include files for X11 programs should be available at ftp://ftp.xfree86.org in the
xdevel section.

If you want to start your system in runlevel 3 using kdm, you need to replace the xdm call in /etc/rc.d/xdm
with /opt/kde/bin/kdm. In any case, here is a version that should work:
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#! /bin/sh 
# Copyright (c) 1996 S.u.S.E. GmbH Fuerth, Germany.  All rights reserved. 
# 
# Author: Florian La Roche <florian@suse.de>, 1996 
#         Werner Fink <werner@suse.de>, 1996 
# 
# Modified on October, 13th by  
#       Andreas Buschka <andi@bonn-online.com>, 1997 
# for the KDE documentation project. 
# 
# /sbin/init.d/xdm 
# 
 
. /etc/rc.config 
 
case "$1" in 
    start) 
        echo "Starting kdm." 
        /opt/kde/bin/kdm 
        ;; 
    stop) 
        echo -n "Shutting down kdm:" 
        killproc -TERM /opt/kde/bin/kdm 
        echo 
        ;; 
    *) 
        echo "Usage: $0 {start|stop}" 
        exit 1 
esac 
 
exit 0 

You also need to change the default runlevel in /etc/inittab to 3 in order to start kdm when the system
comes up.

Do not forget to re-login in order to let the system read your new configuration settings!

3.5 Required Changes To Your Configuration Files

After you have placed the KDE binaries into their destination directory, there are a few adjustments you
must make to your startup scripts.

The following procedure was tested on SuSE Linux 5.0, and should be compatible with the other popular
UNIX's as well. Always make backups of configuration files before changing them! Add the following
to the end of your /etc/profile:

export PATH=$PATH:/opt/kde/bin 
export KDEDIR=/opt/kde

Next, edit the .xinitrc file in your home directory. Look for the line that calls your window manager and
replace it with startkde.

Now that everything needed to run KDE has been installed, you can go on to chapter 4 where you will start
KDE for the first time. If something goes wrong, you may need to compile KDE on your own. Read Using
TGZ to install on top of other systems for more information.

We have made the installation as bulletproof as possible, so you should not encounter any serious
problems unless your configuration is exotic. If you do experience difficulties feel free to use the KDE
mailing lists
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4. First Impressions

"You see to sea to see that all you can see is sea"
(Unknown origin)

First impressions are so important -- this is not only true for Agatha Christie's famous thriller
"The Mousetrap" -- but also for KDE. As we mentioned before, KDE is supposed to be the most
intuitive, easy to learn user interface available. In fact, we will have reached our goal when
users no longer need this book in order to work with KDE, causing the authors to lose their
(unpaid and voluntary) jobs as documentors.

4.1 Starting KDE

When you boot a UNIX system, one of two things should happen (that is, if the system works
correctly; everything else is an undocumented third case). Either you stay in text mode and get
a login prompt or you are presented with a graphical login window. In the former case, you
must log into your system and type:

  
startx  

If the installation was successful, the KDE desktop should appear after a few seconds of
initialization.

If a graphical login window is presented, then all that should be required is your login name and
password. Assuming the KDE installation was successful, KDE should start without further
intervention.

If you have not done so already, we recommend changing your X display manager from xdm to
kdm, which includes the same functionality, but with the advanced features of the K Desktop
Environment.

4.2 Desktop Components

After everything has come up, take some time to explore the new environment. If you have
already worked with Windows 95 or OS/2 Warp 4, many things should look familiar to you. The
three main parts of a KDE desktop are the desktop itself, the panel, and the task list.

Panel

When you start KDE for the first time, the panel is situated at the bottom of the screen. From
here, you will start your programs and switch between the virtual screens.
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K button

Clicking on this button removes the panel from the screen and replaces it with a mini
panel. The K button stays on the screen so you can bring the main panel back. This
feature only applies to the current desktop; the other desktops will keep the mini or main
panel.Hint: When the panel is minimized, the application menu and the task list are
available on top of the taskbar with the same functionality, but they use less space there.

Application starter

The button next to the K button is one of the most important places on your KDE desktop.
From here, you can start all KDE applications installed. Later, when you learn how to use
the K Menu Editor, you can also add other programs here as well. To start a program, just
click on the button. You will see a list of different categories, plus some special entries.
Whenever you move your mouse over an entry that has an arrow to the right, a new
menu will appear. When you find the program you want to start, just click on it with the left
mouse button.

Task list

The button located to the right of the application menu (the one with the monitor on it) is a
menu containing all the windows active on your desktops, sorted by desktop name. This
feature makes it easy to quickly find a particular window and reduces overall desktop
clutter when many windows are open.

Logout button

Located to the right of the list of active windows, there are two more buttons. The top
button, which looks like a big 'X', is used when you want to quit the current KDE session.
If any other applications are still open, three things may happen: Applications which are
written for KDE will prompt you to save your work. When you start KDE again, all the KDE
windows will be opened again and you can start at the same point where you left your
workstation the day before. Applications which were not written explicitly for KDE, but
comply with the X Window System standard will also prompt you to save your work.
Applications which do not fully correspond to this standard (like Netscape Navigator 4.03)
cannot ask you whether you want to save your work. KDE will warn you about these
programs and provide you with the option to stop the logout process. Remember, there
are not many things to save when you are using a web browser, but, for example, a
CAD-program with a valuable drawing loaded should be quit using its own menus before
logging out.

Lock screen button

If you happen to live in a house with others who cannot stop spying on your work, this
button could be handy. One click and it will lock your screen, preventing unwanted
persons from reading your private mail or playing around with your work.
WARNING: The X Window System can still be terminated with Ctrl-Alt-Backspace, but
this will destroy all your work on the KDE desktops. If you do not disable the use of
Ctrl-Alt-Enter, Ctrl-Alt-Backspace and the switching keys to your text consoles, this
protection is not secure!
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Desktop buttons

When you start KDE for the first time, note the four buttons labeled, appropriately enough,
"One", "Two", "Three" and "Four". These represent your four desktops. Just click one of
them. Don't worry; though they have "disappeared", any open windows are still active
(just take a look at the task list!). Using multiple desktops is one of the most powerful
features of KDE and the X Window System. Instead of placing one window over another,
as you would when using Windows or OS/2, you can say "Well, on the first desktop, I will
write the KDE User Guide. On the second desktop I'll run the sgml2latex compiler and
see my results while compiling my linux kernel on the third desktop, and reading my
e-mail on the fourth."

Icon bar

Some people are so lazy that they consider even the two or three motions through the
applications menu to be too much (me included). For them, additional buttons can be
placed next to the desktop buttons; for example, shortcuts to your home directory, to your
trashcan, to the kvt terminal emulator and to the documents you use often. For
information on how to add icons to the taskbar, read Adding icons to your taskbar.

Time and date

At the far right end of the KDE panel, you can always see the time and date.
The task list

Move your mouse to the upper left corner of the screen. There, you will find a button for
each open window. Just click on the button corresponding to the windows you want to
open. This is an alternative to using the task list on the KDE panel.

Using Windows

When KDE comes up, the first opened window contains your home directory. We'll cover the
contents of this window later. Right now, let's investigate the actual window widget.
Window menu

On the top left corner of each window, you can see a window manipulation icon. When
you click on it, a context menu containing commands to manipulate the window is
presented. Maximize will expand the window to the largest size possible. Note that KDE
will take the size of your virtual desktop, which means that the window could be bigger
than your screen. Iconify will make the window invisible. Take a look at the Taskbar. You
will notice that the window title is now shown in (parentheses). To bring the window to the
desktop again, click on the window title. Move will let you move the window with your
mouse. Click on the left mouse button when you have the window where you want it to
be. Resize enables you to make the window smaller or larger. Move your mouse around
and click when you are satisfied with the new size. Sticky will stick the window to your
desktop. Whenever you change the desktop, the "sticky" window will move with you. To
stop this effect, select UnSticky. This is useful, for example, when you are debugging
programs or network problems and you always want to see the tail -f window of the
logfiles. To desktop... enables you to send a window to another desktop. Choose the
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desktop where you want the window to be. The window will disappear at once. To see
your window again, select its name in the Taskbar or click on the appropriate Desktop
Button on the KDE Panel. Close will close the window. Sometimes the application will
allow you to save your work, but it some cases (e.g., old X11 applications) this does not
work. It is best to close an application with its own commands, using this menu item only
as a last resort.

Sticky button

This button looks like a thumbtack. It performs the same operation as the sticky command
in the Window Menu, but requires fewer steps to invoke.

Title bar

The title bar containing the name of the window can be double-clicked in order to
maximize it. Use the right mouse button: The Window menu will reappear, allowing you
to (un)maximize, iconify, move, resize, (un)sticky the window, to move it to another
desktop (this works faster than the method with the sticky button). When a program does
not react anymore, you can close (which will sometimes give you the opportunity to save
your work) it.

Iconify, maximize and close Buttons

To the right of the title bar, there are three buttons that can also be used to iconify,
maximize and close the window (this is faster than using the window manipulation menu).
Iconified windows can be brought back with a click on the taskbar.

To move a window, place the cursor on the title bar and hold down the left mouse button.
Without releasing the mouse button, move the window to the location of your choice, then
release the mouse button. If you want to resize a window, move the mouse cursor to the
window border you wish to change. Once you have reached the correct spot, the cursor will
change from an arrow to a bracket and an arrow. Hold down the left mouse button and drag the
side in question to the location you wish, then release the button. Note that you may drag sides
or corners (which will adjust the size in two dimensions at once.)

Using the menu bar of each KDE window is easy. Just click on what you want to do, and it will
be done. But the menu bar can do even more for you. Notice the sparkled stripe on the left of
the menu and icon bars? Depress your right mouse button and a context menu will appear,
allowing you to put the menu bar on the top or bottom of the window. You can even take the
menu bar out of the window and have it "floating" around.

Below the menu bar, there is a set of tool symbols you can use to execute commands.
Whenever you move over them, an active picture will be marked. You can also put the toolbar
wherever you want: left, right, top, bottom; of course it can be floating, too.

Getting Help

Help is available basically everywhere: On the desktop, just use the right mouse button and
choose Help On Desktop. On the KDE panel, open the application menu and choose Help.
Every KDE program has a help menu. Every help is HTML-based, so using the help system is
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as easy as using your favorite web browser!
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5. Getting Started

"Using only what you see, can you get from A to B?"
(Help for one of the toughest riddles in "the 7th Guest")

Thus far, KDE may appear to be little more than another window manager with some handy
desktop features. But hold onto your seat; in the next few sections, we'll introduce you to
features that'll assure you will never again try to operate your system Unix without KDE!

5.1 Editing Files

Since you do not only have KDE applications installed on your system, you probably know the
mess of editing ASCII style configuration files. But in fact, there are a lot of other file types that
need to be edited this way. For example, the raw SGML source for this guide was written ASCII
style, as was the source code for the KDE programs themselves. We will now show you how
you can use the KEdit facility in KDE to edit ASCII files of your own.

Opening a Window Containing Your Home Directory

Click on the application starter and choose Home directory. A window showing the contents
of your home directory will pop up. To see a more detailed listing of files in your home directory,
do the following:

Select Show Dot Files from the View menu●   

Select Show Tree from the View menu●   

On the left hand of the screen, a tree view of your file system structure should appear, including
any "hidden files" -- files or directories beginning with a period.

The File Manager Screen

We tried to make the File Manager as easy as possible to use, and if you know other window
managers (including those built into other Operating Systems) with integrated file management,
many of the following concepts should be familiar to you.

On the top, there is a File menu which contains functions to open and close file manager
windows. You can also print the current contents.

Want to visit the Internet? Just choose File > Open Location (or press Alt-L) and enter an URL.
For example, if you want to visit the KDE homepage, enter http://www.kde.org. You can also
quickly FTP files using this method. KDE is "Internet ready", which means that you can load
and save files not only on your local hard disk, but also on remote FTP and HTTP servers.
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While other operating systems and desktops make a distinction between local and remote file
systems, KDE does not.

The Edit menu offers functions to select, copy and move files. We will use them later. Already
having used the View menu, you have probably seen that you can view the content in many
different ways. Just play around a bit and see what happens.

You will undoubtedly find the Bookmarks to be extremely useful: Now you can remember
virtually any link, be it on the local machine or somewhere on the Internet.

The Tools menu helps you find the notorious
files-that-I-put-somewhere-I-do-not-remember-anymore.

Navigating Through Directories

We will now pick one of your configuration files and edit it. First, we must change the directory
in the File Manager. Scroll down the tree view on the left side of the screen until you find the
directory /etc. Double-click on etc. You will see a list of files in the right window.

Editing a File

Scroll down until you find the file motd and click on it with the right mouse button. In the context
menu, select Open With. A new window will pop up. Enter

 
kedit 

and click on Ok or press Enter. Viola!

The Editor Screen

The more you work with KDE, the more you will notice that most screens and applications look
and feel the same. The KEdit File menu is a great example of this: Almost every other KDE
program has the same menu, allowing you to create new files, open existing files from your
local file system or (coming soon) even the web, save them (soon even on the web, too!), print
it or mail it to somebody else. The Edit menu can also be found in most KDE applications,
allowing you to cut and paste information between programs. You can also search and replace
text. Using the Options Menu, you can customize the editor in many different ways. For
example, you can increase the font size to suit your monitor resolution -- and your eyes. Of
course, as in any other KDE application, you find a Help Menu, offering you on-line help
whenever you need it.

Using the Editor

Most motd files contain useless stuff like "Do not forget to back up your data" or "Do not annoy
the system manager". Boring. Let's change the text so that users logging in get the really
important information. You can navigate through the text using the arrow keys, and mark
sections of text with Shift-Arrows or by using the mouse with the left button pressed. Use the
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Edit Menu to cut and paste text. Enter whatever you want, or use the following (great) example:

 
Welcome! 
 
This machine now has KDE installed, providing you with a great, 
easy-to-use interface and a consistent Look-and-Feel for all your 
applications. For more information on how to get KDE running on your 
account, please e-mail the administrator. 

Saving Your Work

Now that you have changed the motd file, it is time to save the file, putting the changes into
effect. To do this, you can use either the File Menu, or you can use the Save Icon on the
toolbar. Finally, finish your work by closing the editor and file manager window. You can do this
by clicking the "X" button on the top-right of the window, by using the window menu of the title
bar, or by choosing File > Quit. Simple and elegant, isn't it?

5.2 Moving Files With Drag and Drop

As you have seen in the previous section, working with files is as easy as 1-2-3. However,
when you want to copy and move files, the whole copy-and-paste business can get annoying.
Don't worry -- a procedure called "drag and drop" allows you to copy and move files more
quickly and easily.

Opening Two File Manager Windows

Before you can start, you will need open two file manager windows. The simplest way to open a
new window is to press the white wheel button on the right of the icon bar. If you do not see the
tree view in the new window, activate it (View > Tree View).

Dragging a File From One Window To Another

In the first window, open the /etc folder and scroll until you see the motd file we modified in the
previous section. In the second window, open your home directory. Click on the motd file. Hold
your left mouse button and drag your file into your home directory. Release the left mouse
button (this is called dropping the file). You will be presented three options: copy, move and
link. Link will create a symbolic link to the file, while copy and move do exactly what they say.
Select copy. You should now have a copy of the motd file in your home directory.

5.3 Using Command Line And Terminals

So far, you have only worked with the tools and programs KDE provides. Undoubtedly, you will
want to use other UNIX programs as well. There are two ways of running them: The quick
command line and the terminal.

Quick Command Line
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Pressing Alt-F2 pops up a small window where you can enter a command to run. Please note
that you will not see any text output generated from a program started in this manner! This
method is only recommended for starting X Window System programs or for running tools
where you do not need to see or type anything. For other programs, you will still need to use
the terminal.

The UNIX Terminal Emulator

From the application menu, choose Utilities > Terminal. A terminal window will open. Here you
can use regular UNIX shell commands: ls, cat, less, and so forth. Using the options menu, you
can customize the terminal emulator to suit your needs.

5.4 Finding Your Lost Files

Everyone has undoubtedly encountered the following problem: You start ftp, log into a great
site like ftp.kde.org and start downloading files. It is late in the evening and you shut down your
machine after completing the transfer. The next morning, you are at the keyboard again, and
you start wondering into which directory you placed the recently transferred files. Using KDE's
KFind utility makes finding those lost files a snap.

Starting KFind

Starting KFind is simple: Choose Find Files in the Application Starter. KFind uses an
interface part you probably do not know yet: register tabs. When KFind starts, you see that
Name & Location is selected. When you click on Date Modified, the register content changes.
Since you have never run a search before, most of the icons on the toolbar and most of the
menu entries are disabled. We will change this now.

Finding a File by Knowing Parts of Its Name

As long as you know a bit of the file name, searching is easy. Select the Name & Location tab,
and enter the file name. Wildcards may be used as needed. As a test, type *.tar.gz. By default,
the search begins in your home directory, but you can select any starting directory you wish by
clicking on the Look in or Browse.... To start searching, click the icon (which looks like a
magnifying glass over a sheet of paper) on the left of the toolbar. After a moment, a list of files
will appear in the search results window. If they do not appear, you started the search in the
wrong directory, made a spelling mistake in the name field, or no files ending with a .tar.gz
extension are located on your machine.

Finding a File by More Complex Criteria

There are many categories you can use to make your search more precise. The more you
know about the file, the better are your chances of finding it.
Date modified

Here, you can specify that you only want to see files which were last touched in a given
period of time. You can also specify that you only want to see files that were touched
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since a specified number of months or days ago.
File type

If you know that the file was of a special type (e.g., a tar/gzip archive or a jpeg picture),
you can tell KFind to find only this type of file.

Text string

You can specify text that the file must contain.
Size

If you know the file size, you can limit your search in this regard, as well.

5.5 Using Multiple Desktops

Using multiple desktops helps you organize your work. You can place your programs on
different desktops, and name the desktops so you know what you do there. This increases and
optimizes your workspace. It also helps you when you are surfing the net instead of doing your
work and your boss comes in. But, of course, this is rare -- at least in the office where I work ;).

You can switch between desktops by clicking the desktop buttons on the KDE panel. If you
want to rename them, you can do so by double-clicking on them.

You can use windows on multiple desktops. If you want to have a window present everywhere,
just click the sticky button on the top-left of the window. To send a window to another desktop,
click on the title bar with the right mouse button, choose To Desktop, and select the desktop
where you would like the window moved.

5.6 Quitting KDE

To quit working with KDE, you can use the Logout entry in the application starter menu or the
corresponding button on the panel. You will be asked if you really want to quit KDE. Quitting
will close all windows and return you to your console or display manager. For information on
how programs can save your work during logout, please read the notes for logging out.

Next Previous Table of Contents
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6. All About Your Desktop

"Grandma, what big eyes you have"
(Little Red Hood)

"The better to see you"
(The wolf)

The more you see, the more efficiently you can use your desktop. KDE gives you the
opportunity to make the desktop look and work the you way prefer, enabling you to work faster
and more productively. It even gives you the opportunity to be warned if a wolf is trying to eat
you, or (if you happen to be a granny) alert you when Little Red Hood is on her way to bring
you the goodies. Now that's service.

6.1 The Autostart Folder

Before I discovered the Autostart folder, my daily startup routine with KDE consisted of the
following: Start KDE, start KEdit, start kvt, start Netscape, and start kscd. This took time I could
have spent better. As of the first Beta release, native KDE programs left open at the end of a
session will save their state and reappear when you login again, but there are some programs
(like Netscape) that will not. You can use the Autostart folder for these programs.

To launch programs when KDE is started, do the following:
Open the Autostart folder. You can find it on the upper left corner of you desktop.1.  
Open a filemanager window containing the program you want to add. If you do not
know how to do this, see the section describing kfm, the K Filemanager.

2.  

Drag and Drop the desired program from its source folder into the Autostart folder.
When asked, choose Link to create a symbolic link instead of a full copy. This saves a
great deal of disk space.

3.  

Repeat this step for every program you want started when KDE is launched. Of course,
you may select applications not native to KDE, including Netscape, tin, pine and many
others.

4.  

Restart KDE.5.  

Your programs should now launch automatically when KDE restarted. If you want to add
something special (e.g., you want to see a certain web site when your system goes up), read
Using templates. The procedures described there works for any folder, so you can also apply
them to the Autostart folder, as well.
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6.2 Adding Programs and Shortcut Icons to Your Panel

The KDE panel is not limited to the setup you find right after installing KDE. The KDE panel is
designed to be extended, and there are two ways of doing that: Adding new programs, and
adding shortcut icons.

Programs

To add your favorite programs to the KDE panel, you must use the KDE Menu Editor. To start
it, use the application starter and choose Utilities > Menu Editor. A window containing an
empty button will appear. To change it, click on it using the right mouse button and choose
Change. Next, you should see another window with various options you can set. The Type
dropdown box contains some types of links you can create. Choose Application. Now choose
the Name field and enter the description that will appear in the Application starter. For example,
you can type Netscape Communicator. Next, click on the large and the small picture using the
left mouse button and select an icon for the application. In the Comment field you can
optionally enter a remark about the application. Be sure to choose a helpful comment, because
it will appear as tool-tip in the Application starter. For Netscape, you might enter WWW-Browser
with Mail and News software.

If not already selected, choose the Execute tab and enter the Execute field. Here, you must
type the complete path to your application, for example /usr/local/netscape/netscape. Set the
Working Directory to a value that makes sense, such as /usr/local/netscape. If your application
runs in a terminal, you must select Run In Terminal and specify the Terminal Options. The
terminal options are the command-line switches of kvt; you can see them by using

kvt --help     

in a terminal window. After you have made all the adjustments needed, choose the Ok button
and select File > Save from the main menu. Next, restart your panel by choosing Panel >
Restart from the application starter. You should now find a new entry Personal with the new
menu entries.

Shortcut Icons

Although KDE is much more comfortable than the average Unix window manager, everyone
wants a solution for a one-click way to start a program. Later, you will learn how to create links
and files on your desktop, but this also has some disadvantages: sometimes all your desktops
are filled up with windows, and you cannot reach your icons without minimizing all the windows
that cover them. For commonly used programs, you can minimize this problem and speed
access by creating shortcut icons on the KDE panel.

To create a shortcut on the KDE panel, do the following:
Click on the application starter and choose Panel > Add application.1.  
You will see the top level of the application starter again. Go through the menus to find
the program for which you want to create the shortcut, such as "Home directory" or "kvt".
Click on the program you want.

2.  
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A new icon will appear on the KDE panel. Click on it, and the program will start . If you want to
move the icon, click on it using the right mouse button and choose Move. Move the icon to the
position you want and press the left mouse button. If you wish to remove the icon, click on it
using the right mouse button and choose Remove.

6.3 Creating New Files On Your Desktop

Your desktop can be an efficient place to work. Every time you start KDE, you can see the
complete files, folders and URLs which you often use.

There are two ways to create and edit files on your desktop. In any application, you can say
that you want to save your work in the Desktop subfolder of your home directory. For example,
my home directory is /home/stupiddog, so my Desktop directory is /home/stupiddog/Desktop.
Everything you save there will be put on your desktop.

If you want to move existing files to your Desktop, the best way to achieve this is to use the K
file manager (kfm). Open a file manager window and drag the files you need to your desktop.
You can choose to copy them if you want to keep all your common stuff on the desktop now, or
you can create symbolic links to the real files. Everything you change in the link files will be
automatically updated in the originals. For more information on how to use drag & drop and the
file manager, see the chapter Moving files with drag & drop.

6.4 Placing Links on Your Desktop

Placing files on your desktop may shorten the paths you need to enter. However, sometimes it
would be nice if you could start KEdit with a commonly edited file already opened in it. And how
often do you find yourself frustrated after browsing through endless lists of bookmarks to find a
site you visit often? Wouldn't it be nice if everything necessary to deliver you to that site was
done automatically after clicking a single icon?

Using Templates

Templates provide a convenient mechanism for performing tasks such as those outlined above.
Templates can also be used to associate particular file extensions with a specific application.
When a file ending in a known extension is double-clicked, the application associated with that
extension is automatically started. In short, templates help you get the most out of KDE.

Example: You want to put an icon for visiting the KDE web site on your desktop.
Open the Template folder on your desktop. Here, you can see all the templates you can
use for creating new links and resources. Ftpurl is a template you can use for creating a
link to an FTP site and even to a particular directory. For example, you could create a link
straight to ftp://ftp.kde.org/pub/kde/stable to be informed when a new release is available.
MimeType is a very powerful tool. Because of its complexity I have decided to explain it
in Using MIME types. Program is a general template you can use to start a particular
program with an argument. For example, you could use this to start /usr/src/linux/make
xconfig to configure the kernel. URL is also something general: It is a link to a URL which

1.  
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does not start with http:// or ftp://. Make sure that your link makes sense; kfm cannot
handle Quake servers (yet). WWWUrl is the template we will be using now. It creates a
link to a specific web site.
WARNING:If you started KDE as the system administrator (root), make sure you do not
change the templates unless you know exactly what you are doing! If you destroy a
template, only a new installation of KDE can recreate it!

2.  

Drag the WWWUrl to your desktop (if you do not know about how to use Drag and Drop,
see Drap & Drop for more information.) When asked, choose Copy to create your own
copy of the template you can manipulate.

3.  

Click on the template copy using the right mouse button and choose Properties.4.  
In the dialog box that appears, you will see three tabs: Program, Permission and
URL.Change the filename and permissions as needed, then click on the URL tab.

5.  

In the URL field, you must enter the URL you want to be shown when you click on the
icon. For our example, type http://www.kde.org.

6.  

You can click on the Icon to change the icon for this new shortcut.7.  
If you are satisfied, click Ok to save your changes.8.  

This will update the icon. When you click on it, you will be transferred to the KDE homepage. I
suggest that you play around with templates a bit. They are extremely powerful and can be
customized for almost any need.

Using MIME Types

MIME Types are very powerful. Employing them, you can easily customize your system such
that clicking on a file of a specific type starts the application with which that file type has been
associated. For example, all .mod files could be set to start kmodplayer, .html files could open a
kfm window showing the file, and a core file can be viewed with the Hex Editor by simply
clicking on the core file. Warning: Although MIME types are very powerful, they are not without
dangers. Playing around with MIME types as the system administrator (root) can damage a
KDE system so severely that cannot be restarted! In this example, you will create your personal
MIME style, which is only relevant for you. It will only affect other users if you copy or move it to
/opt/share/mimelnk.

To link a certain file type with a particular application:
Make sure that the application which you want to link to the file type has an entry in the
KDE panel. If it is missing, see Adding Programs to your KDE panel for instructions on
how to create an entry.

1.  

Choose Edit > MIME types in the kfm file manager window.2.  
Think about the type of file for which you want to create an entry. By default, there are
five top level types: Application is for files that are usually created or edited with one
specific application, for example, tar, gzip, and pdfs. Audio is for everything that
generates any kind of tones: waves, midis, mods, etc. Image is for any graphics files like
gif, jpeg or tiff. Text is for everything that is text, for example, plain text, html, C and
Pascal source code, tex documents and tcl scripts. Finally Video is for any type of video

3.  
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streaming like mpeg. Decide to which category your type belongs and change to the
matching directory.
Open the Template folder, which is accessible as an icon on your desktop.4.  
Drag & Drop the Mimetype icon into the other window and copy it.5.  
Right click the copied icon and select Properties. Edit the properties of your type.6.  
Click on Binding. You will now see a mask which requires five entries.7.  
The first field must be filled with the file suffix. For example, if you want to create a new
type for SGML documents, you should type *.sgml; *.SGML; here. Any file ending with
.sgml or .SGML will now be handled with the new type.

8.  

Enter a description for the type in the Comment field. For the SGML example, it could be
"SGML document"

9.  

Enter the MIME type. It is built with the directory (text/ for the SGML example) and a
name you choose. For the SGML example, you would enter text/sgml as the Mime-Type.
KDE will inform you if there already is a convention on which prefix to use for your type.
The kfm web browser will also depend on this setting when you download a document of
this type from the web!

10.  

Choose an application that is used to edit this file from the dropdown box. For the SGML
example, we simply use the Editor.

11.  

Click on the icon to choose an icon. Every file matching the suffix you entered will appear
with this icon when shown in the file manager window.

12.  

Click Ok to save the new type.13.  

Try your new association by opening a directory containing a file of the type you just selected.
Click on the file, and the program needed to edit it should start. If something goes wrong or
your system cannot even start anymore, use a text console (or kdm's emergency shell function)
to delete the link. That should make everything fine.

Defining Your Own Templates

By default, KDE provides you with five default templates which can build new links on your
desktop. However, sometimes you will want to create a new template. Doing this is simple:

Login with root privileges.1.  
Create the file as usual.2.  
Move or copy it into the Template folder.3.  
Whenever you want to reuse your new template, copy it from the template folder onto
your desktop or into a directory, rename it, and use it. Since the Template folder is only
writable by you, nobody can accidentally destroy the template (that is, if he or she is not
you. It might be a good idea to prevent even you from being able to write to this file, to
avoid accidentally damaging it).

4.  
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6.5 Using the Font Manager

The KDE font manager takes care that you only work with the fonts you really need. You can
decide whether or not to use the set of fonts in your X11 font directory. You can start the font
manager using the Application Starter. The font manager can be found in the System folder.
When you start it, you will see the list of X11 fonts available in the left window and the fonts
used by kde in the right window. If you wish to add or remove the ability to use these fonts in
KDE, click on any of them and decide to add or to remove it.

The Font test tab can be used to preview how a font will look. Choose the font family, subtype,
size and attributes and you will get a preview.

Understanding the Raw X11 Font List

There are many entries when you click on the Tab raw X11 fonts. The KDE font manager
already shows you the combinations which make sense, and lets you see which entries were
useless to it. There is nothing you can do with this list except view it.

6.6 Using the Trashcan

Under normal circumstances, deleting a file under UNIX is something which cannot be undone.
However, with the KDE file manager, you can choose Move to Trashcan instead of Delete.
This will move the file into the Trash Folder, which, by default, is accessible as an icon on your
desktop. In the Trash Folder, you can always recover deleted files. Remember to empty the
trashcan regularly by clicking on it using the right mouse button, then choosing Empty
trashcan, otherwise you might run out of disk space because the files still need space. Note,
however, that once you empty the Trash Folder, the files contained therein are lost forever.
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7. Customizing KDE: The K Control Center

"Actually, we are talking about peanuts."
(The president of a well-known German bank after the financial scandal surrounding Dr.
Juergen Schneider)

The K Control Center gives you full control over your desktop, giving it its individual touch by
changing the setting of all those little peanuts. To start it, choose KDE Control Panel from the
Application Starter. The K Control Center comes up and gives you some basic information
about your system.

7.1 Desktop

When you start KDE for the first time, you can see a white background and buttons for your
desktops. You might agree with me that this does not look very exciting, so we need something
to change it. Click on the Desktop in the selection list.

Background

Maybe the first feature that everyone wants to customize, the background tab gives you full
control about the background you are working with. There are two types of background: Colors
(and color gradients) and "real" background images. You can change the settings for every
desktop individually by choosing it with the left and right arrows.

Notice the color window first. You can see the currently selected color (some type of gray or
white if you have not customized KDE yet) and the options Flat and Gradient. If you choose
Flat, then your background will only consist of one single, unmodified color you can select. Try
selecting Gradient. You will see another color selector and two more options appear. Click on
the color selector and pick a color of your choice. When you get back, you already have a
preview of how the screen will look. If you choose Portrait, the color gradient will be vertically
(from the top to the bottom of the screen), otherwise it will be painted horizontally (from the left
to the right).

If you prefer to have a "real" background image instead of a color gradient, take a look at the
right end of the window. Be sure to disable the color gradient, otherwise the background
picture will NOT appear! There is a dropdown control from where you can select a
background picture. KDE provides you with three samples, but you can use the Browse...
button to take any one you have available. Next, you should choose what to do with pictures
that do not fit the screen exactly (this happens almost every time). If your picture is too small,
Tiled is a good solution. Your picture will be copied as often as needed to fill the screen. This is
the default. Centered will place your picture in the middle of the screen. The rest will be painted
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with the color you selected earlier (be sure to have its state set to Flat). The last option,
Scaled, will stretch the picture until it matches the desktop in size.

Colors

If the backgrounds did not provide you with the level of individuality you need, these options
surely will. Click on the Color Schemes tab. Here, you can set the colors for all the screen
elements individually. Click on the Widget box on the left and select an element whose color
you want to change. If you do not know what everything is, you can also click on the sample.
Next, click on the Color Selector below the widget box and choose a color you like. Play
around a little bit and see what you like best. If you do not get the results you want, you can
also try one of the predefined schemes in the list box on the right. Once you get it the way you
want it, be sure to save it using the Save button. You can also set the level of contrast for your
color scheme; this is especially handy if you are working with a portable computer and light
makes it difficult to decipher the display.

Screensaver

Many older monitors have a really bad habit if you forget to turn them off while going out of your
room; when they display a picture too long, they tend to like it so much that they want to display
it as a shadow forever. Unfortunately, there is no way of stopping this unholy friendship
between your monitor and the picture, but there are ways of preventing it: Screen Savers.

Click on the Screensavers register tab. Here you can set the screensaver delay. You can also
password protect the screensaver so that it will be necessary to enter your password to
continue. If you decide to set this, make sure to set the wait period not too short! It is annoying
to type in the password every minute because the screen saver was activated while you were
thinking about some project. The priority slider enables you to control how much CPU time the
screen saver is allowed to take. If you compile big programs in the background or you are using
your UNIX box as a server, you better set this to Low.

Next, click around the screen saver list and pick a saver that you like. You can test it using the
Test button, located to the right of the screen saver list. Many screen savers have additional
options you can set by using the Setup button.

Style

You can change the general appearance of the KDE controls ("widgets") if you prefer a desktop
that looks more like Windows 95. You can also set the default font. For example, if your display
is small and the resolution high, you might find this handy.

Titlebar

After the installation, KDE applications always have the full KDE title bar, containing the window
menu, sticky button, title bar itself, minimize, maximize and close buttons. If you do not want to
have all of these buttons or want to change their positions, you can change the title bar settings
in the register Buttons.. Choose whether you want to have a button or menu on the left or the
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right side. Off means that it will not be displayed at all. Be careful: If you do not know
alternative methods for the window actions (like the keyboard shortcut table), you can get into
serious problems using your desktop. Beware!

The Appearance register contains two settings: At first, you can decide if the window title bar
should be drawn using a color gradient or just (this is faster) with a plain color. If a window title
is wider than the title bar, the text will be scrolled from left to right and backwards. With the Title
Animation setting, you can decide how fast this happens.

Windows

This will change the behavior of the windows themselves:
Window Movement

You can tell KDE to move the windows with their entire content (this may be slow on your
machine) or only to move the opaque, which is slightly faster.

Resize Animation

This will animate the window while you resize it. Turn this off if KDE gets too slow.
Focus Policy

It often can be helpful to switch to a window without having to press a button. If you want
to be able to do this, choose Focus follows mouse and set the number of seconds to
wait before rising the window under the mouse cursor.

Maximize Style

For some reason, you may want your windows only to be maximized vertically. See the
Shortcut Table for information on how to achieve the same with mouse and keyboard.

7.2 Sound System

Using the sound system panel, you can easily adjust settings to the sound output KDE and its
applications produce.

Bell

KDE generates various warning signals, called beeps, when you make a mistake (e.g. copying
a file into a folder you do not have access to). You can adjust the settings for these beeps here:
Volume

Sets the volume of the beep. You can set it from 0% (no beep) to 100% (you should think
carefully before making a mistake after setting this...)

Pitch

Adjusts the frequency of the tone. Ranges go from 0 (no beep) up to 2000 (you should
not set this unless you have no pets like dogs or bats.)

Duration
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Tells KDE how long the tone is played.

7.3 Input Devices

You can use several input devices with the X Window System (and thus with KDE). You can
change their settings here:

Keyboard

Here, you can set whether a character is repeated when you keep pressing its key. If you have
a bad keyboard and need the clicking after you hit a key, you can also turn on the key click
volume.

Mouse

The Mouse is the most frequently used pointing device around, and for the majority of computer
owners, the most intuitive method of navigating through KDE. (For some owners with bad mice,
it is also a reason for visiting the doctor very often, see Drag & Drop for information.)

Acceleration

Sets the speed of the mouse. The higher the setting, the faster your mouse will move
around the screen.

Threshold

Threshold is the distance the pointer must move (in a small amount of time) before
accelerated movement occurs. 0 disables it.

Try to experiment with these settings; the right combination will allow you to point exactly on
short distances and to move fast over long ones.

7.4 Panel Settings

You can also access the Panel Settings by selecting the Application Starter and choosing
Panel > Configure. A new window containing three register tabs will pop up.

Panel and Taskbar

On the first tab, you can tell KDE where you want the panel and the taskbar to be displayed.
You can also use the dropdown field to set the size of the panel bar if your display is always
too full.

Options

On this tab you can enable or diasable tool tips. If you enable tool tips you should set the
duration between the mouse over a menu and when the tool tip for that menu pops up. Next
you can set if you want the Panel Bar and/or the Taskbar to auto hide when the mouse is not
over them. The final option lets you set the clock to 24 hour or AM/PM format.
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Note: The previous information relates to the KPanel Configuration window. The K Control
Center part will be updated.

Desktops

As discussed earlier, desktops give you more space and help you organize your work. By
clicking on the Desktops register tab, you can customize them. Notice the two sliders at the
bottom of the window. The Visible sliders lets you set the number of desktops you can access,
Width sets the size of their icons on the panel bar. Activate as many desktops as you need.
You can now edit their names in the upper part of the windows.

7.5 System Information

There are no settings to be changed here. Instead, you will be given information about the
available memory and information about your processor(s).

7.6 Network

KDE offers you complete network management via the KDE Control Centre (kcc) (when it will
be finished). This makes your life as a potential UNIX system administrator very easy: From
now on, setting up servers will be faster and easier. Because configuration is easier, there will
be fewer mistakes and the security problems caused by them.

Samba Network Status

This point gives you information about the users that are connected to your UNIX box via the
SMB (Session Message Block) Protocol. SMB is the protocol used mainly by Windows 95 and
WindowsNT machines to share files and folders.
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8. Tips & Tricks for Your Daily Work

"Everyone can make an omelet with eggs. The trick is to make one with none."
(Fortune Cookies)

Nearly everyone can use KDE; this is why the developers made it. There are no cryptic
switches with which to cope, and few configuration files you need edit in ASCII style. However,
there are some ways you can do your work more elegantly, saving you time for the truly
important things, like tetris.

8.1 Shortcut Table

Alt-Esc or Control-Esc

Shows the KDE session manager, from which you can switch to a specific application or
log out of KDE.

Alt-Tab or Alt-Shift-Tab

Cycle through the windows
Ctrl-Tab or Ctrl-Shift-Tab

Cycle through your desktops
Alt-F2

Command line
Alt-F3

Window Menu
Alt-F4

Close the current window
Ctrl-F[1..8]

Switch to a specific desktop
Ctrl-Alt-Esc

Window destroyer (every window you click on will be destroyed)
Ctrl-Alt-Backspace

This exits KDE (without saving!) Use this as a last resort
Ctrl-Alt-Numpad +
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Cycles to the next screen resolution
Ctrl-Alt-Numpad -

Cycles to the previous screen resolution

8.2 Mouse Techniques

Clicking on the border or the titlebar

Left: Activates and raises the window, Middle: Activates and lowers the window, Right:
Shows window menu if the window is active, activates it otherwise.

Doubleclick on the window title

Maximizes the window
Drag on the titlebar

Moves the window around
Drag on corners or edges

Resizes the window
Alt-Left Button

Moves the window around
Alt-Middle Button

Raises the window
Alt-Right Button

Resizes the window
Click on the Icon on the top left

Window Menu
Click on the Sticky Button

toggles sticky
Clicking on Maximize

Left: Maximizes the window, Middle: Maximizes only vertically, Right:Maximizes
horizontally

Click on Close

Closes the window, program asks you whether to save your work or not.
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8.3 Activating the Screen Saver by Moving Your Mouse to a Corner

Besides the Lock Screen Button on the K Panel, there is another way you can invoke the K
screen savers: Go into the screen saver settings (Application Starter > System > Screen
Settings) and click on one of the corners of the sample screen. Three options will be
presented. Ignore will ignore any movement of the mouse into that corner. Save will invoke the
screen saver after the mouse pointer resides in the corner for more than 5 seconds. Lock will
do the same as Save, but it will ask for your login password.
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9. Entertainment Applications

You can get the following applications in the kdegames distributions.

Stable applications are relatively bug free and come in source and binary formats.

ftp.kde.org/pub/kde/stable/latest/distribution/stable

Unstable versions change daily and are only in source form, meaning you must compile them
to get a working version. Remember these are unstable and might not even compile. If you
have a problem with an unstable application report the problem and it will most likely be fixed in
a future snapshot.

ftp.kde.org/pub/kde/unstable/CVS/snapshots/current

9.1 Kmines

9.2 Kpoker

9.3 Ktetris
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10. Graphical Applications

You can get the following Applications in the kdegraphics distributions.

Stable applications are relatively bug free and come in source and binary formats.

ftp.kde.org/pub/kde/stable/latest/distribution/stable

Unstable versions change daily and are only in source form, meaning you must compile them
to get a working version. Remember these are unstable and might not even compile. If you
have a problem with an unstable application report the problem and it will most likely be fixed in
a future snapshot.

ftp.kde.org/pub/kde/unstable/CVS/snapshots/current

10.1 Kfract - Fractal Generator

10.2 Kview - Image Viewer

Kview is an image viewer that displays the following formats: JPEG, GIF, XPM, XBM PNM,
BMP, PCX, ILBM, TGA and EPS. KView supports drag and drop with other KDE applications.

Display Manager

The List Box

The list of all images you have loaded into Kview. You can select images to be displayed by
using command line: kview $KDEDIR/share/wallpapers/* This opens Kview with all the installed
wallpapers on your system.

Once Kview is running you can use drag and drop with the filemanager to deposit images into
the list box. The other two methods of loading an image are the File Open button and the File ->
Open menu option.

To display an image in the list box, double-click on it and an Image Window will open with the
image.

Image Window(s)

Pressing the right mouse button on an image brings up a menu with the following options:

Zoom
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If you want to display the image in greater detail or at a smaller size use one of the zoom
factors: -50%, -10%, +10%, +50%.

Rotate

You can rotate or mirror the image with this option.
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11. Multimedia Applications

You can get the following applications in the kdemultimedia distributions.

Stable applications are relatively bug free and come in source and binary formats.

ftp.kde.org/pub/kde/stable/latest/distribution/stable

Unstable versions change daily and are only in source form, meaning you must compile them
to get a working version. Remember these are unstable and might not even compile. If you
have a problem with an unstable application report the problem and it will most likely be fixed in
a future snapshot.

ftp.kde.org/pub/kde/unstable/CVS/snapshots/current

11.1 Kmix - Sound Mixer Panel

11.2 Kmedia - Media Player
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12. Network Applications

You can get the following applications in the kdenetwork distributions.

Stable applications are relatively bug free and come in source and binary formats.

ftp.kde.org/pub/kde/stable/latest/distribution/stable

Unstable versions change daily and are only in source form, meaning you must compile them
to get a working version. Remember these are unstable and might not even compile. If you
have a problem with an unstable application report the problem and it will most likely be fixed in
a future snapshot.

ftp.kde.org/pub/kde/unstable/CVS/snapshots/current

12.1 Kmail - Mail Client

12.2 Knu - Network Utilities

12.3 Krn - News Client

Next Previous Table of Contents

K Desktop Environment : Network Applications 

http://www.kde.org/documentation/userguide/index-12.html [14/09/1999 10:32:41]

http://www.kde.org/
ftp://ftp.kde.org/pub/kde/stable/latest/distribution/
ftp://ftp.kde.org/pub/kde/unstable/CVS/snapshots/current/


The K Desktop
Environment

Next Previous Table of Contents

13. Utility Applications

You can get the following applications in the kdeutilities distributions.

Stable applications are relatively bug free and come in source and binary formats.

ftp.kde.org/pub/kde/stable/latest/distribution/stable

Unstable versions change daily and are only in source form, meaning you must compile them
to get a working version. Remember these are unstable and might not even compile. If you
have a problem with an unstable application report the problem and it will most likely be fixed in
a future snapshot.

ftp.kde.org/pub/kde/unstable/CVS/snapshots/current
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14. Frequently Asked Questions About KDE

"What are you?"
"I'm your worst nightmare..."
(Batman Animated Series)

There are some questions that are always raised on the KDE mailing lists. To keep the traffic
as low as possible (making the lists more readable), we have included them in this section. So
please be kind and do not ask them in the mailing lists anymore - think of the quote above!

14.1 What Does "KDE" Stand For?

KDE stands for the "K Desktop Environment", which itself is intended to be a collection of small
tools, a window manager, a file manager and tools that bring all this together. It is created to
make your life with UNIX easier.

14.2 I Cannot Compile Package xxx

Always be sure that you have the newest version of the KDE libraries installed. The software is
in constant development, so the dependencies can change from one day to another. You may
also find the general compilation hints helpful. Another problem could be that you are using a
program written for a very old version of KDE, which depends on outdated include files. Please
check the file dates. They should be more recent the dates of your current KDE version.

14.3 KDE is Not Stable

KDE is being developed in two forks, one for bleeding edge development, the other for normal
use (where stability is considered to be important.) One can, in general, obtain KDE in many
ways. Obtaining pre-compiled binaries in a package format (rpm,deb,tgz) labelled with a
particular version (ie. 1.1) is the best way to encourage stability on your KDE desktop.

The price of stability is that one must wait for each release to get new features. If you want the
latest and greatest versions of software, you may have to go with source code, perhaps even to
the point of CVS snapshots. These are daily snapshots of whatever the developers are working
on, and some things are guaranteed to be broken. DO NOT RELY ON CVS SNAPSHOTS TO
MAINTAIN OPERATIONAL DESKTOPS. You will get burned eventually!
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14.4 Other Sources for Help

Take a look at the KDE Web-Site for the most up-to-date information available about KDE on
the web. You may also want to subscribe to our mailing lists.

Send mail to the specified address with subscribe your email address in the subject line in
order to get subscribed:

KDE common mailing list, kde-request@kde.org

KDE developers' mailing list, kde-devel-request@kde.org

KDE look and feel discussions, kde-look-request@kde.org

KDE announcements, kde-announce-request@kde.org

KDE licensing questions, kde-licensing-request@kde.org

KDE users' list, kde-user-request@kde.org

KDE Documentators' list, kde-doc-request@kde.org
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15. Epilogue

"She had her moments, she had some style,
the best show in town was the crowd,
outside the Casa Rossada crying
'Eva Peron'; but that's all gone now..."
(the end of Evita)

We hope that you found this documentation useful, informative and perhaps even entertaining.
If you would like to tell us your opinion or suggest improvements, see the section Contacting
the authors for further information. The following things are not necessary to understand the
KDE Desktop Environment, but you still may want to read it.

15.1 The K Documentation Staff

Andreas Buschka

The one responsible for the greatest part of this. Read about KDE in the German
computer magazine c't and has been addicted to it ever since. Likes: Italian food,
swimming, role playing games (GURPS, DSA), Sabrina Setlur's music and everything
that has to do with romance. Hates: Mondays, seeing KDE not compiling, sunny weather,
senseless lyrics, a famous software company from Redmond, USA.
E-Mail: andi@circe.tops.net

Robert D. Williams

Created the first version and currently the coordinator.
E-mail: rwilliam@kde.org

Poul Gerhard

Contributed corrections and changes
John Waalkes

Contributed corrections and changes
Vernon Wells

Contributed corrections and changes
Kay Lutz

Contributed corrections and changes
Stephan Kulow
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Our professional Installer...
E-Mail: coolo@kde.org

French Translation

John B. Perr
E-Mail: jperro@mail.change-espace.fr

German Translation

Oliver Hensel
E-Mail: Oliver.Hensel@gmx.net

Itailian Translation

Antonio Esposito
E-Mail: antonio.esposito@star1.change-espace.fr

Polish Translation

Piotr Roszatycki
E-Mail: dexter@fnet.com.pl

Portuguese Translation

Goncalo Valverde
E-Mail: grumbler@esoterica.pt

Spanish Translation

Gustavo Cavazos
E-Mail: gcavazos@yahoo.com

Russian Translation

Sergey Orlovsky
E-Mail: cyberian@cyberia.math.nsc.ru

English Reviewer

Peter Silva
E-Mail: Peter.Silva@kde.org

15.2 We still need people!

KDE is a huge project, and every KDE supporter has already realized that. All of us are trying
very hard to create a user interface that is easy to use and maybe also has the potential to
make UNIX ready for the desktop PC. You have the chance to participate in this project too,
and we would be thankful if you did. Developers and interested users communicate via several
mailing lists described in mailing-lists . If you would like to help, please do so! We are still
looking for helpers in the following departments:

Development (Libraries and Applications)●   

Documentation●   
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Graphics●   

Beta-Testing●   

and everywhere else, too :-)●   

15.3 Legal notices

This book may be freely published under the terms of the GNU General Public License (GPL)
and contains copyrighted material from Andreas Buschka, Gerhard Poul and Robert David
Williams. All trademarks and branded names mentioned are properties of their legal owners.

15.4 Sources of information used during the creation of this book

During the creation of this documentation, the authors used the following sources for
information:

The KDE Mailing lists●   

Various README and HTML help files that came with the KDE components●   

ksgml2html for creating the web version of this document●   

15.5 Greetings

Andreas Buschka:

For keeping my working morale up:
Robert David Williams

For musical support during the work:
Madonna (and the Evita Soundtrack)
Enigma (and "MCMXC", "The Cross Of Changes" and "Le Roi Est Mort, Vive Le Roi!")
The Verve (and "Bittersweet Symphony")
Sabrina Setlur (and "Die neue S-Klasse")

No thanks to:
A famous software company, located in Redmond, USA
Severin "stop this boring stuff and get playing volley ball" L.
Stefan "you do not seriously believe they will take this s..." L.

15.6 GNU General Public License

The following is a copy of the GNU general public license, version 2. If you do not know what it
is good for, here a short synopsis:

KDE and the results of the KDP project team's work are meant to be available to the public, for
the benefit of everyone. But making it PD or Freeware would not protect the work in the
necessary way. Nobody would prevent commercial software companies from abusing our work
to speed up their own development process. This is why the GPL is KDE's choice.
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                    GNU GENERAL PUBLIC LICENSE 
                       Version 2, June 1991 
 
 Copyright (C) 1989, 1991 Free Software Foundation, Inc. 
                          675 Mass Ave., Cambridge, MA 02139, USA 
 Everyone is permitted to copy and distribute verbatim copies 
 of this license document, but changing it is not allowed. 
 
                            Preamble 
 
  The licenses for most software are designed to take away your 
freedom to share and change it.  By contrast, the GNU General Public 
License is intended to guarantee your freedom to share and change free 
software--to make sure the software is free for all its users.  This 
General Public License applies to most of the Free Software 
Foundation's software and to any other program whose authors commit to 
using it.  (Some other Free Software Foundation software is covered by 
the GNU Library General Public License instead.)  You can apply it to 
your programs, too. 
 
  When we speak of free software, we are referring to freedom, not 
price.  Our General Public Licenses are designed to make sure that you 
have the freedom to distribute copies of free software (and charge for 
this service if you wish), that you receive source code or can get it 
if you want it, that you can change the software or use pieces of it 
in new free programs; and that you know you can do these things. 
 
  To protect your rights, we need to make restrictions that forbid 
anyone to deny you these rights or to ask you to surrender the rights. 
These restrictions translate to certain responsibilities for you if you 
distribute copies of the software, or if you modify it. 
 
  For example, if you distribute copies of such a program, whether 
gratis or for a fee, you must give the recipients all the rights that 
you have.  You must make sure that they, too, receive or can get the 
source code.  And you must show them these terms so they know their 
rights. 
 
  We protect your rights with two steps: (1) copyright the software, and 
(2) offer you this license which gives you legal permission to copy, 
distribute and/or modify the software. 
 
  Also, for each author's protection and ours, we want to make certain 
that everyone understands that there is no warranty for this free 
software.  If the software is modified by someone else and passed on, we 
want its recipients to know that what they have is not the original, so 
that any problems introduced by others will not reflect on the original 
authors' reputations. 
 
  Finally, any free program is threatened constantly by software 
patents.  We wish to avoid the danger that redistributors of a free 
program will individually obtain patent licenses, in effect making the 
program proprietary.  To prevent this, we have made it clear that any 
patent must be licensed for everyone's free use or not licensed at all. 
 
  The precise terms and conditions for copying, distribution and 
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modification follow. 
  
                    GNU GENERAL PUBLIC LICENSE 
   TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION 
 
  0. This License applies to any program or other work which contains 
a notice placed by the copyright holder saying it may be distributed 
under the terms of this General Public License.  The "Program", below, 
refers to any such program or work, and a "work based on the Program" 
means either the Program or any derivative work under copyright law: 
that is to say, a work containing the Program or a portion of it, 
either verbatim or with modifications and/or translated into another 
language.  (Hereinafter, translation is included without limitation in 
the term "modification".)  Each licensee is addressed as "you". 
 
Activities other than copying, distribution and modification are not 
covered by this License; they are outside its scope.  The act of 
running the Program is not restricted, and the output from the Program 
is covered only if its contents constitute a work based on the 
Program (independent of having been made by running the Program). 
Whether that is true depends on what the Program does. 
 
  1. You may copy and distribute verbatim copies of the Program's 
source code as you receive it, in any medium, provided that you 
conspicuously and appropriately publish on each copy an appropriate 
copyright notice and disclaimer of warranty; keep intact all the 
notices that refer to this License and to the absence of any warranty; 
and give any other recipients of the Program a copy of this License 
along with the Program. 
 
You may charge a fee for the physical act of transferring a copy, and 
you may at your option offer warranty protection in exchange for a fee. 
 
  2. You may modify your copy or copies of the Program or any portion 
of it, thus forming a work based on the Program, and copy and 
distribute such modifications or work under the terms of Section 1 
above, provided that you also meet all of these conditions: 
 
    a) You must cause the modified files to carry prominent notices 
    stating that you changed the files and the date of any change. 
 
    b) You must cause any work that you distribute or publish, that in 
    whole or in part contains or is derived from the Program or any 
    part thereof, to be licensed as a whole at no charge to all third 
    parties under the terms of this License. 
 
    c) If the modified program normally reads commands interactively 
    when run, you must cause it, when started running for such 
    interactive use in the most ordinary way, to print or display an 
    announcement including an appropriate copyright notice and a 
    notice that there is no warranty (or else, saying that you provide 
    a warranty) and that users may redistribute the program under 
    these conditions, and telling the user how to view a copy of this 
    License.  (Exception: if the Program itself is interactive but 
    does not normally print such an announcement, your work based on 
    the Program is not required to print an announcement.) 
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These requirements apply to the modified work as a whole.  If 
identifiable sections of that work are not derived from the Program, 
and can be reasonably considered independent and separate works in 
themselves, then this License, and its terms, do not apply to those 
sections when you distribute them as separate works.  But when you 
distribute the same sections as part of a whole which is a work based 
on the Program, the distribution of the whole must be on the terms of 
this License, whose permissions for other licensees extend to the 
entire whole, and thus to each and every part regardless of who wrote it. 
 
Thus, it is not the intent of this section to claim rights or contest 
your rights to work written entirely by you; rather, the intent is to 
exercise the right to control the distribution of derivative or 
collective works based on the Program. 
 
In addition, mere aggregation of another work not based on the Program 
with the Program (or with a work based on the Program) on a volume of 
a storage or distribution medium does not bring the other work under 
the scope of this License. 
 
  3. You may copy and distribute the Program (or a work based on it, 
under Section 2) in object code or executable form under the terms of 
Sections 1 and 2 above provided that you also do one of the following: 
 
    a) Accompany it with the complete corresponding machine-readable 
    source code, which must be distributed under the terms of Sections 
    1 and 2 above on a medium customarily used for software interchange; or, 
 
    b) Accompany it with a written offer, valid for at least three 
    years, to give any third party, for a charge no more than your 
    cost of physically performing source distribution, a complete 
    machine-readable copy of the corresponding source code, to be 
    distributed under the terms of Sections 1 and 2 above on a medium 
    customarily used for software interchange; or, 
 
    c) Accompany it with the information you received as to the offer 
    to distribute corresponding source code.  (This alternative is 
    allowed only for noncommercial distribution and only if you 
    received the program in object code or executable form with such 
    an offer, in accord with Subsection b above.) 
 
The source code for a work means the preferred form of the work for 
making modifications to it.  For an executable work, complete source 
code means all the source code for all modules it contains, plus any 
associated interface definition files, plus the scripts used to 
control compilation and installation of the executable.  However, as a 
special exception, the source code distributed need not include 
anything that is normally distributed (in either source or binary 
form) with the major components (compiler, kernel, and so on) of the 
operating system on which the executable runs, unless that component 
itself accompanies the executable. 
 
If distribution of executable or object code is made by offering 
access to copy from a designated place, then offering equivalent 
access to copy the source code from the same place counts as 
distribution of the source code, even though third parties are not 
compelled to copy the source along with the object code. 
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  4. You may not copy, modify, sublicense, or distribute the Program 
except as expressly provided under this License.  Any attempt 
otherwise to copy, modify, sublicense or distribute the Program is 
void, and will automatically terminate your rights under this License. 
However, parties who have received copies, or rights, from you under 
this License will not have their licenses terminated so long as such 
parties remain in full compliance. 
 
  5. You are not required to accept this License, since you have not 
signed it.  However, nothing else grants you permission to modify or 
distribute the Program or its derivative works.  These actions are 
prohibited by law if you do not accept this License.  Therefore, by 
modifying or distributing the Program (or any work based on the 
Program), you indicate your acceptance of this License to do so, and 
all its terms and conditions for copying, distributing or modifying 
the Program or works based on it. 
 
  6. Each time you redistribute the Program (or any work based on the 
Program), the recipient automatically receives a license from the 
original licensor to copy, distribute or modify the Program subject to 
these terms and conditions.  You may not impose any further 
restrictions on the recipients' exercise of the rights granted herein. 
You are not responsible for enforcing compliance by third parties to 
this License. 
 
  7. If, as a consequence of a court judgment or allegation of patent 
infringement or for any other reason (not limited to patent issues), 
conditions are imposed on you (whether by court order, agreement or 
otherwise) that contradict the conditions of this License, they do not 
excuse you from the conditions of this License.  If you cannot 
distribute so as to satisfy simultaneously your obligations under this 
License and any other pertinent obligations, then as a consequence you 
may not distribute the Program at all.  For example, if a patent 
license would not permit royalty-free redistribution of the Program by 
all those who receive copies directly or indirectly through you, then 
the only way you could satisfy both it and this License would be to 
refrain entirely from distribution of the Program. 
 
If any portion of this section is held invalid or unenforceable under 
any particular circumstance, the balance of the section is intended to 
apply and the section as a whole is intended to apply in other 
circumstances. 
 
It is not the purpose of this section to induce you to infringe any 
patents or other property right claims or to contest validity of any 
such claims; this section has the sole purpose of protecting the 
integrity of the free software distribution system, which is 
implemented by public license practices.  Many people have made 
generous contributions to the wide range of software distributed 
through that system in reliance on consistent application of that 
system; it is up to the author/donor to decide if he or she is willing 
to distribute software through any other system and a licensee cannot 
impose that choice. 
 
This section is intended to make thoroughly clear what is believed to 
be a consequence of the rest of this License. 
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  8. If the distribution and/or use of the Program is restricted in 
certain countries either by patents or by copyrighted interfaces, the 
original copyright holder who places the Program under this License 
may add an explicit geographical distribution limitation excluding 
those countries, so that distribution is permitted only in or among 
countries not thus excluded.  In such case, this License incorporates 
the limitation as if written in the body of this License. 
 
  9. The Free Software Foundation may publish revised and/or new versions 
of the General Public License from time to time.  Such new versions will 
be similar in spirit to the present version, but may differ in detail to 
address new problems or concerns. 
 
Each version is given a distinguishing version number.  If the Program 
specifies a version number of this License which applies to it and "any 
later version", you have the option of following the terms and conditions 
either of that version or of any later version published by the Free 
Software Foundation.  If the Program does not specify a version number of 
this License, you may choose any version ever published by the Free Software 
Foundation. 
 
  10. If you wish to incorporate parts of the Program into other free 
programs whose distribution conditions are different, write to the author 
to ask for permission.  For software which is copyrighted by the Free 
Software Foundation, write to the Free Software Foundation; we sometimes 
make exceptions for this.  Our decision will be guided by the two goals 
of preserving the free status of all derivatives of our free software and 
of promoting the sharing and reuse of software generally. 
 
                            NO WARRANTY 
 
  11. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY 
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW.  EXCEPT WHEN 
OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES 
PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK AS 
TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU.  SHOULD THE 
PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, 
REPAIR OR CORRECTION. 
 
  12. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, 
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING 
OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT NOT LIMITED 
TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY 
YOU OR THIRD PARTIES OR A FAILURE OF THE PROGRAM TO OPERATE WITH ANY OTHER 
PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 
 
                     END OF TERMS AND CONDITIONS 
  
        Appendix: How to Apply These Terms to Your New Programs 
 
  If you develop a new program, and you want it to be of the greatest 
possible use to the public, the best way to achieve this is to make it 
free software which everyone can redistribute and change under these terms. 
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  To do so, attach the following notices to the program.  It is safest 
to attach them to the start of each source file to most effectively 
convey the exclusion of warranty; and each file should have at least 
the "copyright" line and a pointer to where the full notice is found. 
 
    <one line to give the program's name and a brief idea of what it does.> 
    Copyright (C) 19yy  <name of author> 
 
    This program is free software; you can redistribute it and/or modify 
    it under the terms of the GNU General Public License as published by 
    the Free Software Foundation; either version 2 of the License, or 
    (at your option) any later version. 
 
    This program is distributed in the hope that it will be useful, 
    but WITHOUT ANY WARRANTY; without even the implied warranty of 
    MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE.  See the 
    GNU General Public License for more details. 
 
    You should have received a copy of the GNU General Public License 
    along with this program; if not, write to the Free Software 
    Foundation, Inc., 675 Mass Ave., Cambridge, MA 02139, USA. 
 
Also add information on how to contact you by electronic and paper mail. 
 
If the program is interactive, make it output a short notice like this 
when it starts in an interactive mode: 
 
    Gnomovision version 69, Copyright (C) 19yy name of author 
    Gnomovision comes with ABSOLUTELY NO WARRANTY; for details type `show w'. 
    This is free software, and you are welcome to redistribute it 
    under certain conditions; type `show c' for details. 
 
The hypothetical commands `show w' and `show c' should show the appropriate 
parts of the General Public License.  Of course, the commands you use may 
be called something other than `show w' and `show c'; they could even be 
mouse-clicks or menu items--whatever suits your program. 
 
You should also get your employer (if you work as a programmer) or your 
school, if any, to sign a "copyright disclaimer" for the program, if 
necessary.  Here is a sample; alter the names: 
 
  Yoyodyne, Inc., hereby disclaims all copyright interest in the program 
  `Gnomovision' (which makes passes at compilers) written by James Hacker. 
 
  <signature of Ty Coon>, 1 April 1989 
  Ty Coon, President of Vice 
 
This General Public License does not permit incorporating your program into 
proprietary programs.  If your program is a subroutine library, you may 
consider it more useful to permit linking proprietary applications with the 
library.  If this is what you want to do, use the GNU Library General 
Public License instead of this License. 
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